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About This Manual

This manual describes how to use NI-VISA, the National Instruments
implementation of the VISA I/O standard, in any environment using
LabWindows/CVI, any ANSI C compiler, or Microsoft Visual Basic. It is
intended to increase ease of use for end users through open, multivendor
systems, specifically through VISA I/O software. The assumption is made
that a user of VISA software and this manual is familiar with programming
I/O software for VXI, GPIB, Serial, PXI, and Ethernet technology on one
or more of the following operating systems:

• Windows 2000/NT/XP/Me/9x
• LabVIEW RT

• Solaris 2.x

• Mac OS 8/9/X

• Linux x86

• VxWorks x86

How to Use This Document Set
Use the documentation that came with your GPIB and/or VXI hardware
and software for Windows to install and configure your system.

Refer to the Read Me First document for information on installing the
NI-VISA distribution media.

Use the NI-VISA User Manual for detailed information on how to program
using VISA.

Use the NI-VISA online help or the NI-VISA Programmer Reference
Manual for specific information about the attributes, events, and
operations, such as format, syntax, parameters, and possible errors.

� Windows users—The NI-VISA Programmer Reference Manual is not
included in Windows kits. Windows users can access this information
through the NI-visa.hlp file at Start»Programs»National
Instruments»VISA»VISA Help .
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Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setupitem, and select Options
from the last dialog box.

� The � symbol indicates that the following text applies only to a specific
product, a specific operating system, or a specific software version.

This icon denotes a tip, which alerts you to advisory information.

bold Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.

Related Documentation
The following documents contain information that you may find helpful as
you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface
for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats,
Protocols, and Common Commands
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• ANSI/IEEE Standard 1014-1987, IEEE Standard for a Versatile
Backplane Bus: VMEbus

• ANSI/IEEE Standard 1155-1992, VMEbus Extensions for
Instrumentation: VXIbus

• ANSI/ISO Standard 9899-1990, Programming Language C

• NI-488.2 Function Reference Manual for DOS/Windows, National
Instruments Corporation

• NI-488.2 User Manual for Windows, National Instruments
Corporation

• NI-VXI Programmer Reference Manual, National Instruments
Corporation

• NI-VXI User Manual, National Instruments Corporation

• VPP-1, Charter Document
• VPP-2, System Frameworks Specification

• VPP-3.1, Instrument Drivers Architecture and Design Specification

• VPP-3.2, Instrument Driver Functional Body Specification
• VPP-3.3, Instrument Driver Interactive Developer Interface

Specification

• VPP-3.4, Instrument Driver Programmatic Developer Interface
Specification

• VPP-4.3, The VISA Library
• VPP-4.3.2, VISA Implementation Specification for Textual Languages

• VPP-4.3.3, VISA Implementation Specification for the G Language

• VPP-5, VXI Component Knowledge Base Specification

• VPP-6, Installation and Packaging Specification
• VPP-7, Soft Front Panel Specification

• VPP-8, VXI Module/Mainframe to Receiver Interconnection

• VPP-9, Instrument Vendor Abbreviations
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1
Introduction

This chapter discusses how to use this manual, lists what you need to
get started, and contains a brief description of the VISA Library. The
National Instruments implementation of VISA is known as NI-VISA.

How to Use This Manual
This manual provides a sequential introduction to setting up a system to use
VISA and then using and programming the environment. Please gather all
the components described in the next section, What You Need to Get
Started. The Read Me First document included with your kit explains how
to install and set up your system.

Once you have set up your system, you can use Chapter 2, Introductory
Programming Examples, to guide yourself through some simple examples.
Chapters 3 through 8 contain more in-depth information about the
different elements that make up the VISA system.

For GPIB users or those familiar with NI-488, suggested reading is
Chapter 2, Introductory Programming Examples, Chapter 5,
Message-Based Communication, and the GPIB section in Chapter 9,
Interface Specific Information. For VXI users or those familiar with
NI-VXI, suggested reading is Chapter 2, Introductory Programming
Examples, Chapter 6, Register-Based Communication, and the VXI section
in Chapter 9, Interface Specific Information.

What You Need to Get Started
� Appropriate hardware, in the form of a National Instruments GPIB,

GPIB-VXI, MXI/VXI or serial interface board. For other hardware
interfaces, the computer’s standard ports should be sufficient for most
applications.

� For GPIB applications, install NI-488. For VXI applications, install
NI-VXI. For other hardware interfaces, NI-VISA uses the system’s
standard drivers.
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� NI-VISA distribution media

� If you have a GPIB-VXI command module from another vendor, you
need that vendor’s GPIB-VXI VISA component. It will be installed
into the <VXIPNPPATH>\<Framework >\bin directory. For example,
the Hewlett-Packard component for the HPE1406 would be:

C:\VXIpnp\Win95\bin\HPGPVX32.dll

Introduction to VISA
The main objective of the VXIplug&play Systems Alliance is to increase
ease of use for end users through open, multi-vendor systems. The alliance
members share a common vision for multi-vendor systems architecture,
encompassing both hardware and software. This common vision enables
the members to work together to define and implement standards for
system-level issues.

As a step toward industry-wide software compatibility, the alliance
developed one specification for I/O software—the Virtual Instrument
System Architecture, or VISA. The VISA specification defines a
next-generation I/O software standard not only for VXI, but also for GPIB,
Serial, and other interfaces. With the VISA standard endorsed by over 35
of the largest instrumentation companies in the industry including
Tektronix, Hewlett-Packard, and National Instruments, VISA unifies the
industry to make software interoperable, reusable, and able to stand the test
of time. The alliance also grouped the most popular operating systems,
application development environments, and programming languages into
distinct frameworks and defined in-depth specifications to guarantee
interoperability of components within each framework.

This manual describes how to use NI-VISA, the National Instruments
implementation of the VISA I/O standard, in any environment using
LabWindows/CVI, any ANSI C compiler, or Microsoft Visual Basic.
NI-VISA currently supports the frameworks and programming languages
shown in Table 1-1. For information on programming VISA from
LabVIEW, refer to the VISA documentation included with your LabVIEW
software.
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You may find that programming with NI-VISA is not significantly different
from programming with other I/O software products. However, the
programming concepts, model, and paradigm that NI-VISA uses create a
solid foundation for taking advantage of VISA’s more powerful features in
the future.

Table 1-1. NI-VISA Support

Operating System Programming Language/Environment
VXI plug&play

Framework

Windows Me/98/95 LabWindows/CVI, ANSI C, Visual Basic WIN95

Windows Me/98/95 LabVIEW GWIN95

Windows 2000/NT/XP LabWindows/CVI, ANSI C, Visual Basic WINNT

Windows 2000/NT/XP LabVIEW GWINNT

LabVIEW RT LabVIEW *

Solaris 2.x LabWindows/CVI, ANSI C SUN

Solaris 2.x LabVIEW GSUN

Mac OS 8/9/X ANSI C, LabVIEW *

Linux x86 ANSI C, LabVIEW *

VxWorks x86 ANSI C *

* This framework is supported by NI-VISA even though it is not defined by the VXIplug&play Systems Alliance.
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2
Introductory Programming
Examples

This chapter introduces some examples of common communication
with instruments. To help you become comfortable with VISA, the
examples avoid VISA terminology. Chapter 3, VISA Overview, looks at
these examples again but using VISA terminology and focusing more
on how they explain the VISA model.

Note The examples in this chapter show C source code. You can find the same examples
in Visual Basic syntax in Appendix A, Visual Basic Examples.

Example of Message-Based Communication
Serial, GPIB, and VXI systems all have a definition of message-based
communication. In GPIB and serial, the messages are inherent in the design
of the bus itself. For VXI, the messages actually are sent via a protocol
known as word serial, which is based on register communication. In either
case, the end result is sending or receiving strings.

Example 2-1 shows the basic steps in any VISA program.
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Example 2-1
#include "visa.h"

#define MAX_CNT 200

int main(void) 
{

ViStatus status; /* For checking errors */
ViSession defaultRM, instr; /* Communication channels */
ViUInt32 retCount; /* Return count from string I/O */
ViChar buffer[MAX_CNT]; /* Buffer for string I/O */

/* Begin by initializing the system*/
status = viOpenDefaultRM(&defaultRM);
if (status < VI_SUCCESS) {

/* Error Initializing VISA...exiting*/
return -1;

}

/* Open communication with GPIB Device at Primary Addr 1*/ 
/* NOTE: For simplicity, we will not show error checking*/ 
status = viOpen(defaultRM, "GPIB0::1::INSTR", VI_NULL, VI_NULL, 

&instr); 

/* Set the timeout for message-based communication*/ 
status = viSetAttribute(instr, VI_ATTR_TMO_VALUE, 5000);

/* Ask the device for identification */
status = viWrite(instr, "*IDN?\n", 6, &retCount);
status = viRead(instr, buffer, MAX_CNT, &retCount);

/* Your code should process the data */

/* Close down the system */
status = viClose(instr);
status = viClose(defaultRM);
return 0;

}
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Example 2-1 Discussion
We can break down Example 2-1 into the following steps.

1. Begin by initializing the VISA system. For this task you use
viOpenDefaultRM(), which opens a communication channel with
VISA itself. This channel has a purpose similar to a telephone line. The
function call is analogous to picking up the phone and dialing the
operator. From this point on, the phone line, or the value output from
viOpenDefaultRM(), is what connects you to the VISA driver. Any
communication on the line is between you and the VISA driver only.
Chapter 3, VISA Overview, has more details about
viOpenDefaultRM(), but for now it is sufficient for you to
understand that the function initializes VISA and must be the first
VISA function called in your program.

2. Now you must open a communication channel to the device itself using
viOpen(). Notice that this function uses the handle returned by
viOpenDefaultRM(), which is the variable defaultRM in the
example, to identify the VISA driver. You then specify the address of
the device you want to talk to. Continuing with the phone analogy, this
is like asking the operator to dial a number for you. In this case, you
want to address a GPIB device at primary address 1 on the GPIB0 bus.
The value for x in the GPIBx token (GPIB0 in this example) indicates
the GPIB board to which your device is attached. This means that you
can have multiple GPIB boards installed in the computer, each
controlling independent buses. For more information on address
strings, viOpen(), and viOpenDefaultRM(), see Chapter 4,
Initializing Your VISA Application.

The two VI_NULL values following the address string are not
important at this time. They specify that the session should be
initialized using VISA defaults. Finally, viOpen() returns the
communication channel to the device in the parameter instr.
From now on, whenever you want to talk to this device, you use
the instr variable to identify it. Notice that you do not use the
defaultRM handle again. The main use of defaultRM is to tell the
VISA driver to open communication channels to devices. You do not
use this handle again until you are ready to end the program.

3. At this point, set a timeout value for message-based communication.
A timeout value is important in message-based communication to
determine what should happen when the device stops communicating
for a certain period of time. VISA has a common function to set values
such as these: viSetAttribute(). This function sets values such as
timeout and the termination character for the communication channel.
In this example, notice that the function call to viSetAttribute()
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sets the timeout to be 5 s (5000 ms) for both reading and writing
strings.

4. Now that you have the communication channel set up, you can perform
string I/O using the viWrite() and viRead() functions. Notice
that this is the section of the programming code that is unique for
message-based communication. Opening communication channels,
as described in steps 1 and 2, and closing the channels, as described in
step 5, are the same for all VISA programs. The parameters that these
calls use are relatively straightforward.

a. First you identify which device you are talking to with instr.

b. Next you give the string to send, or what buffer to put the
response in.

c. Finally, specify the number of characters you are interested in
transferring.

For more information on these functions, see Chapter 5,
Message-Based Communication. Also refer to the NI-VISA online
help or the NI-VISA Programmer Reference Manual.

5. When you are finished with your device I/O, you can close the
communication channel to the device with the viClose() function.

Notice that the program shows a second call to viClose(). When you
are ready to shut down the program, or at least close down the VISA
driver, you use viClose() to close the communication channel that
was opened using viOpenDefaultRM().

Example of Register-Based Communication

Note You can skip over this section if you are exclusively using GPIB or serial
communication. Register-based programming applies only to VXI, GPIB-VXI, or PXI.

VISA has two standard methods for accessing registers. The first method
uses High-Level Access functions. You can use these functions to specify
the address to access; the functions then take care of the necessary details
to perform the access, from mapping an I/O window to checking for
failures. The drawback to using these functions is the amount of software
overhead associated with them.

To reduce the overhead, VISA also has Low-Level Access functions. These
functions break down the tasks done by the High-Level Access functions
and let the program perform each task itself. The advantage is that you can
optimize the sequence of calls based on the style of register I/O you are
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about to perform. However, you must be more knowledgeable about how
register accesses work. In addition, you cannot check for errors easily. The
following example shows how to perform register I/O using the High-Level
Access functions, which is the method we recommend for new users. If you
are an experienced user or understand register I/O concepts, you can use the
Low-Level Access Operations section in Chapter 6, Register-Based
Communication.

Note Examples 2-2 through 2-4 use bold text to distinguish lines of code that are different
from the other examples in this chapter.

Example 2-2
#include "visa.h"

int main(void) 
{

ViStatus status; /* For checking errors */
ViSession defaultRM, instr; /* Communication channels */
ViUInt16 deviceID; /* To store the value */

/* Begin by initializing the system*/
status = viOpenDefaultRM(&defaultRM);
if (status < VI_SUCCESS) {

/* Error Initializing VISA...exiting*/
return -1;

}

/* Open communication with VXI Device at Logical Addr 16 */
/* NOTE: For simplicity, we will not show error checking */
status = viOpen(defaultRM, "VXI0::16::INSTR", VI_NULL, VI_NULL, 

&instr);

/* Read the Device ID, and write to memory in A24 space */
status = viIn16(instr, VI_A16_SPACE, 0, &deviceID);
status = viOut16(instr, VI_A24_SPACE, 0, 0x1234);

/* Close down the system */
status = viClose(instr);
status = viClose(defaultRM);
return 0;

}
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Example 2-2 Discussion
The general structure of this example is very similar to that of Example 2-1.
For this reason, we merely point out the basic differences as denoted in
bold text:

• A different address string is used for the VXI device.

• The string functions from Example 2-1 are replaced with register
functions.

The address string is still the same format as the address string in
Example 2-1, but it has replaced the GPIB with VXI. Again, remember
that the difference in the address string name is the extent to which the
specific interface bus will be important. Indeed, since this is a simple string,
it is possible to have the program read in the string from a user input or a
configuration file. Thus, the program can be compiled and is still portable
to different platforms, such as from a GPIB-VXI to a MXIbus board.

As you can see from the programming code, you use different functions to
perform I/O with a register-based device. The functions viIn16() and
viOut16() read and write 16-bit values to registers in either the A16, A24,
or A32 space of VXI. As with the message-based functions, you start by
specifying which device you want to talk to by supplying the instr
variable. You then identify the address space you are targeting, such as
VI_A16_SPACE.

The next parameter warrants close examination. Notice that we want
to read in the value of the Device ID register for the device at logical
address 16. Logical addresses start at offset 0xC000 in A16 space, and each
logical address gets 0x40 bytes of address space. Because the Device ID
register is the first address within that 0x40 bytes, the absolute address of
the Device ID register for logical address 16 is calculated as follows:

0xC000 + (0x40 * 16) = 0xC400

However, notice that the offset we supplied was 0. The reason for this is that
the instr parameter identifies which device you are talking to, and
therefore the VISA driver is able to perform the address calculation itself.
The 0 indicates the first register in the 0x40 bytes of address space, or the
Device ID register. The same holds true for the viOut16() call. Even in
A24 or A32 space, although it is possible that you are talking to a device
whose memory starts at 0x0, it is more likely that the VXI Resource
Manager has provided some other offset, such as 0x200000 for the
memory. However, because instr identifies the device, and the Resource
Manager has told the driver the offset address of the device’s memory, you
do not need to know the details of the absolute address. Just provide the
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offset within the memory space, and VISA does the rest. For more detailed
information about other defined VXI registers, refer to the NI-VXI User
Manual.

Again, when you are done with the register I/O, use viClose() to shut
down the system.

Example of Handling Events
When dealing with instrument communication, it is very common for the
instrument to require service from the controller when the controller is not
actually looking at the device. A device can notify the controller via a
service request (SRQ), interrupt, or a signal. Each of these is an
asynchronous event, or simply an event. In VISA, you can handle these and
other events through either callbacks or a software queue.

Callbacks
Using callbacks, you can have sections of code that are never explicitly
called by the program, but instead are called by the VISA driver whenever
an event occurs. Due to their asynchronous nature, callbacks can be
difficult to incorporate into a traditional, sequential flow program.
Therefore, we recommend the queuing method of handling events for new
users. If you are an experienced user or understand callback concepts, look
at the Callbacks section in Chapter 7, VISA Events.

Queuing
When using a software queue, the VISA driver detects the asynchronous
event but does not alert the program to the occurrence. Instead, the driver
maintains a list of events that have occurred so that the program can retrieve
the information later. With this technique, the program can periodically
poll the driver for event information or halt the program until the event has
occurred. Example 2-3 programs an oscilloscope to capture a waveform.
When the waveform is complete, the instrument generates a VXI interrupt,
so the program must wait for the interrupt before trying to read the data.
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Example 2-3
#include "visa.h"

int main(void)
{

ViStatus status; /* For checking errors */
ViSession defaultRM, instr; /* Communication channels */
ViEvent eventData; /* To hold event info */
ViUInt16 statID; /* Interrupt Status ID */

/* Begin by initializing the system */ 
status = viOpenDefaultRM(&defaultRM);
if (status < VI_SUCCESS) {

/* Error Initializing VISA...exiting */
return -1;

}

/* Open communication with VXI Device at Logical Address 16*/
/* NOTE: For simplicity, we will not show error checking */
status = viOpen(defaultRM, "VXI0::16::INSTR", VI_NULL, VI_NULL, 

&instr);

/* Enable the driver to detect the interrupts */ 
status = viEnableEvent(instr, VI_EVENT_VXI_SIGP, VI_QUEUE, VI_NULL);

/* Send the commands to the oscilloscope to capture the */
/* waveform and interrupt when done */ 

status = viWaitOnEvent(instr, VI_EVENT_VXI_SIGP, 5000, VI_NULL, 
&eventData);

if (status < VI_SUCCESS) {
/* No interrupts received after 5000 ms timeout */
viClose(defaultRM);
return -1;

}

/* Obtain the information about the event and then destroy the*/
/* event. In this case, we want the status ID from the interrupt.*/
status = viGetAttribute(eventData, VI_ATTR_SIGP_STATUS_ID, &statID);
status = viClose(eventData);

/* Your code should read data from the instrument and process it.*/
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/* Stop listening to events */ 
status = viDisableEvent(instr, VI_EVENT_VXI_SIGP, VI_QUEUE);

/* Close down the system */ 
status = viClose(instr);
status = viClose(defaultRM);
return 0;

}

Example 2-3 Discussion
Programming with events presents some new functions to use.
The first two functions you notice are viEnableEvent() and
viDisableEvent(). These functions tell the VISA driver which events
to listen for—in this case VI_EVENT_VXI_SIGP, which covers both VXI
interrupts and VXI signals. In addition, these functions tell the driver how
to handle events when they occur. In this example, the driver is instructed
to queue (VI_QUEUE) the events until asked for them. Notice that instr is
also supplied to the functions, since VISA performs event handling on a
per-communication-channel basis.

Once the driver is ready to handle events, you are free to write code that will
result in an event being generated. In the example above, this is shown as a
comment block because the exact code depends on the device. After you
have set the device up to interrupt, the program must wait for the interrupt.
This is accomplished by the viWaitOnEvent() function. Here you
specify what events you are waiting for and how long you want to wait. The
program then blocks, and that thread performs no other functions, until the
event occurs. Therefore, after the viWaitOnEvent() call returns, either it
has timed out (5 s in the above example) or it has caught the interrupt. After
some error checking to determine whether it was successful, you can obtain
information from the event through viGetAttribute(). When you are
finished with the event data structure (eventData), destroy it by calling
viClose() on it. You can now continue with the program and retrieve the
data. The rest of the program is the same as the previous examples.

Notice the difference in the way you can shut down the program if a timeout
has occurred. You do not need to close the communication channel with the
device, but only with the VISA driver. You can do this because when a
driver channel (defaultRM) is closed, the VISA driver closes all I/O
channels opened with it. So when you need to shut down a program quickly,
as in the case of an error, you can simply close the channel to the driver and
VISA handles the rest for you. However, VISA does not clean up anything

NIVISAUM.book Page 9 Thursday, October 4, 2001 5:10 PM



Chapter 2 Introductory Programming Examples

NI-VISA User Manual 2-10 ni.com

not associated with VISA, such as memory you have allocated. You are still
responsible for those items.

Example of Locking
Occasionally you may need to prevent other applications from using the
same resource that you are using. VISA has a service called locking that
you can use to gain exclusive access to a resource. VISA also has another
locking option in which you can have multiple sessions share a lock.
Because lock sharing is an advanced topic that may involve inter-process
communication, see the Lock Sharing section in Chapter 8, VISA Locks, for
more information. Example 2-4 uses the simpler form, the exclusive lock,
to prevent other VISA applications from modifying the state of the
specified serial port.

Example 2-4
#include "visa.h"

#define MAX_CNT 200

int main(void) 
{

ViStatus status; /* For checking errors */
ViSession defaultRM, instr; /* Communication channels */
ViUInt32 retCount; /* Return count from string I/O */
ViChar buffer[MAX_CNT]; /* Buffer for string I/O */

/* Begin by initializing the system*/
status = viOpenDefaultRM(&defaultRM);
if (status < VI_SUCCESS) {

/* Error Initializing VISA...exiting*/
return -1;

}

/* Open communication with Serial Port 1*/ 
/* NOTE: For simplicity, we will not show error checking*/ 
status = viOpen(defaultRM, "ASRL1::INSTR", VI_NULL, VI_NULL, &instr); 

/* Set the timeout for message-based communication*/ 
status = viSetAttribute(instr, VI_ATTR_TMO_VALUE, 5000);

NIVISAUM.book Page 10 Thursday, October 4, 2001 5:10 PM



Chapter 2 Introductory Programming Examples

© National Instruments Corporation 2-11 NI-VISA User Manual

/* Lock the serial port so that nothing else can use it*/
status = viLock(instr, VI_EXCLUSIVE_LOCK, 5000, VI_NULL, VI_NULL);

/* Set serial port settings as needed*/
/* Defaults = 9600 Baud, no parity, 8 data bits, 1 stop bit*/
status = viSetAttribute(instr, VI_ATTR_ASRL_BAUD, 2400);
status = viSetAttribute(instr, VI_ATTR_ASRL_DATA_BITS, 7);

/* Set this attribute for binary transfers, skip it for this text example */
/* status = viSetAttribute(instr, VI_ATTR_ASRL_END_IN, 0); */

/* Ask the device for identification */
status = viWrite(instr, "*IDN?\n", 6, &retCount);
status = viRead(instr, buffer, MAX_CNT, &retCount);

/* Unlock the serial port before ending the program*/
status = viUnlock(instr);

/* Your code should process the data*/

/* Close down the system */
status = viClose(instr);
status = viClose(defaultRM);
return 0;

}

Example 2-4 Discussion
As you can see, the program does not differ with respect to controlling the
instrument. The ability to lock and unlock the resource simply involves
inserting the viLock() and viUnlock() operations around the code that
you want to ensure is protected, as far as the instrument is concerned.

To lock a resource, you use the viLock() operation on the session to the
resource. Notice that the second parameter is VI_EXCLUSIVE_LOCK. This
parameter tells VISA that you want this session to be the only session that
can access the device. The next parameter, 5000, is the time in milliseconds
you are willing to wait for the lock. For example, another program may
have locked its session to the resource before you. Using this timeout
feature, you can tell your program to wait until either the other program has
unlocked the session, or 5 s have passed, whichever comes first.
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The final two parameters are used in the lock sharing feature of viLock()
and are discussed further in Chapter 8, VISA Locks. For most applications,
however, these parameters are set to VI_NULL. Notice that if the viLock()
call succeeds, you then have exclusive access to the device. Other programs
do not have access to the device at all. Therefore, you should hold a lock
only for the time you need to program the device, especially if you are
designing an instrument driver. Failure to do so may cause other
applications to block or terminate with a failure.

When using a VISA lock over the Ethernet, the lock applies to any machine
using the given resource. For example, calling viLock() when using a
National Instruments ENET Serial controller prevents other machines from
performing I/O on the given serial port.

To end the example, the application calls viUnlock() when it has
acquired the data from the instrument. At this point, the resource is
accessible from any other session in any application.
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3
VISA Overview

This chapter contains an overview of the VISA Library.

Background
The history of instrumentation reached a milestone with the ability to
communicate with an instrument from a computer. Controlling instruments
programmably brought a great deal of power and flexibility with the
capability to control devices faster and more accurately without the need
for human supervision. Over time, application development environments
such as LabVIEW and LabWindows/CVI eased the task of programming
and increased productivity, but instrumentation system developers were
still faced with the details of programming the instrument or the device
interface bus.

Instrument programmers require a software architecture that exports the
capabilities of the devices, not just the interface bus. In addition, the
architecture needs to be consistent across the devices and interface buses.
The VISA library realizes these goals. It results in a simpler model to
understand, reduces the number of functions the user needs to learn, and
significantly reduces the time and effort involved in programming different
interfaces. Instead of using a different Application Programming Interface
(API) devoted to each interface bus, you can use the VISA API whether
your system uses an Ethernet, GPIB, GPIB-VXI, VXI, PXI, or Serial
controller.

Finally, most instruments export a specific set of commands to which they
will respond. These commands are often primitive functions of the device
and require several commands to group them together so that the device can
perform common tasks. As a result, communicating directly with the
device may require much overhead in the form of multiple commands to do
task A, do task B, and so on. By driving the formation of the VXIplug&play
Systems Alliance and the IVI Foundation, National Instruments has
spearheaded standards for higher-level instrument drivers that use VISA.
This makes it easier for the vendors of instruments to create the instrument
drivers themselves, so that instrumentation system developers do not have
to learn the primitive command sets of each device.
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Interactive Control of VISA
NI-VISA comes with a utility called VISA Interactive Control (VISAIC)
on all platforms that support VISA, with the exception of Macintosh and
VxWorks. This utility gives you access to all of VISA’s functionality
interactively, in an easy-to-use graphical environment. It is a convenient
starting point for program development and learning about VISA.

When VISAIC runs, it automatically finds all of the available resources in
the system and lists the instrument descriptors for each of these resources
under the appropriate resource type. This information is displayed on the
VISA I/O tab.

The following figure shows the VISAIC opening window.

Figure 3-1. VISAIC Opening Window

The Soft Front Panelstab of the main VISAIC panel gives you the option
to launch the soft front panels of any VXIplug&play instrument drivers that
have been installed on the system.

The NI I/O tab gives you the option to launch the NI-VXI interactive utility
or the NI-488 interactive utility. This gives you convenient links into the
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interactive utilities for the drivers VISA calls in case you would like to try
debugging at this level.

Double-clicking on any of the instrument descriptors shown in the VISAIC
window opens a session to that instrument. Opening a session to the
instrument produces a window with a series of tabs for interactively
running VISA commands. The exact appearance of these tabs depends on
which compatibility mode VISAIC is in. To access the compatibility mode
and other VISAIC preferences select Edit»Preferences… to bring up the
following window.

The VISA implementations are slightly different in LabVIEW and
LabWindows/CVI. These differences are reflected in the operation tabs
that are shown when you open a session to a resource.

� Windows users—VISAIC detects whether you have LabVIEW and/or
LabWindows/CVI installed on your system and sets the compatibility
mode accordingly.

If you change the preferences, the new preferences take effect for any
subsequent session you open.

When a session to a resource is opened interactively, a window similar to
the following appears. This window uses the LabVIEW compatibility
mode.
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determine whether the memory resides in A24 or A32 space by querying
the attribute VI_ATTR_MEM_SPACE.

Shared Memory Sample Code
The following example shows how these shared memory operations work
by incorporating them into Example 6-1. Their main purpose is to allocate
a block of memory from the pool that can then be accessed through the
standard register-based access operations (high level or low level). The
INSTR resource for this device ensures that no two sessions requesting
memory receive overlapping blocks.

Note Example 6-2 uses bold text to distinguish lines of code that are different from those
in Example 6-1.

Example 6-2
#include "visa.h"

#define ADD_OFFSET (addr, offs)  (((ViPByte)addr) + (offs))

int main(void)

{
ViStatus status; /* For checking errors */
ViSession defaultRM, self; /* Communication channels */
ViAddr address; /* User pointer */
ViBusAddress offset; /* Shared memory offset */
ViUInt16 addrSpace; /* Shared memory space */
ViUInt16 value; /* To store register value */

/* Begin by initializing the system */
status = viOpenDefaultRM(&defaultRM);
if (status < VI_SUCCESS) {

/* Error Initializing VISA...exiting */
return -1;

}

/* Open communication with VXI Device at Logical Address 0 */
/* NOTE: For simplicity, we will not show error checking */
status = viOpen(defaultRM, "VXI0::0::INSTR", VI_NULL, VI_NULL, 

&self);

/* Allocate a portion of the device's memory */
status = viMemAlloc(self, 0x100, &offset);
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